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Don‟t forget to visit  our 

club‟s site at:                                    

http://gtbpcug.org 

In Memoriam 

Al Miller, Vice President of the Greater Tampa                            

Bay PC User Group, passed away on April 16,                          

2010, after a long battle with cancer.  

Al was one of the earliest members of our club,                          

starting back in the 1980's when a small group                               

of Texas Instrument (TI) users used to meet in                             

the same building that currently hosts our group.                           

As pc's became more prevalent, the group's                                   

focus changed accordingly. 

From the early days Al was always involved in helping run and 

guide the group, holding a number of  different titles over the years, 

Most recently, while he held the office of Vice President, he also 

handled the group's contacts with Brandon High School, and 

helped keep the group's meeting schedule in line with the school's.   

In addition, he maintained the club's membership roster, sent out 

notifications of  up coming meetings, and greeted and introduced 

guests and new members. As a result, he knew most of the mem-

bers by sight and by name. And, on numerous occasions, he also 

visited member's homes to help them with their computer prob-

lems. 

In 2003 he initiated the custom of, and usually made all the prepa-

rations for, the group having an informal dinner gathering during 

the holidays, and he was "famous" for his way of hosting the      

Chinese Raffle, a gift exchange.  

After the group incorporated in July,1999 as a non-profit 501(c)3 

organization, he helped maintain the group's by-laws, and offered 

his helpful suggestions when changes were needed. During  Lead-

ership meetings, he was a frequent contributor of ideas to help 

maintain and enlarge the group's membership and, as many mem-

bers know, he personally was instrumental in getting a number of 

members to serve as officers and SIG leaders. 

His cheerful demeanor, and his dedication to the group, will be 

sorely missed.  

http://www.gtbpcug.org/
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The minutes of the meeting April 6, 2010 

When it comes to office applications like Excel, most PC users are not aware of how useful they 
are, and how easy it is to create them. Patrick Courtney, in his special presentation, tried to shed 
some light on the subject when using Excel or similar spreadsheet applications.                             
He opened with a short history lesson about spreadsheet development, from VisiCalc to Lotus 1-2-3 
to the current ones available. Formulas, Commands, Rows, Columns, and Cells were explained and 
demonstrated. While he noted there are 250 formulas available in Excel, Patrick limited the demon-
stration to just a few of them! For the more curious PC user there is always the "Help" file, which will 
guide the user.                                                                                                                                 
Two guests this evening were joined by two new members, as well as two officers from the Tampa 
PC Users Group, Doug Mills and  Ron Weinberg, joined us for this evening's meeting. For some 
time Doug has been interested in arranging an exchange of "member presenters," whereby the two 
clubs arrange that members who are willing to make presentations to their own club also might 
make those same presentations to the other club. It was noted that our Patrick Courtney has al-
ready made two presentations to the TPCUG. Doug and Ron also wanted to see how we run 
our meetings and how we're organized. They saw that we try to keep things simple and relaxed, 
and as casual as possible.                                                                                                               
Gary Staley's Treasurer's report was not completed and could not be read. It will be read at the next 
meeting during which Gary has agreed to be a presenter and talk about Computer Basics.   

No meeting on April 13, 2010, Spring brake.  

Minutes of the meeting April 20, 2010 

"Unable to open this file. No program associated to open it". That's when "Irfanview" comes in. It 
almost could be called an all-around program, it has so many functions. Darrell Manns in his Win-
dows SIG only had time to demonstrate a few. It's main function however, is to be used as a file 
conversion program. The list of file extensions is endless Irfanview is able to open.                      
Darrell also demonstrated another little utility called "ShieldsUp", a firewall function checker.                            
Faststone Image Viewer, only available for free in an older version, also was subject of a brief dis-
cussion.                                                                                                                                                
A suggestion was made by a member regarding MS Office 2010. Anybody purchasing a version of 
MS Office 2007 before June of 2010 will be allegeable for a free upgrade of this latest version. 
There should be more specific information on the Microsoft web site.  

Minutes of the meeting April 27, 2010 

As so many times before, Jerry Harris during his Internet SIG had to try to find an answer for so 
many non Internet related questions. A print job could not be canceled for one member, followed by 
the appearance of the familiar red X instead of the picture sent in an e-mail and a question about a 
non-existing program associated with a file that will not open. This particular subject had been     
addressed in detail at the last meeting a week ago.  An answer can be found in the minutes.        
Microsoft provides viewers still free of charge for those computer users who don't have the full    

program needed to open certain files. (See next page for links at member Don Miller’s Website) 

A new member, Marge Winkler, was introduced. Welcome to the club. 

Webmaster Parker Monroe pointed out the location of a memoriam to Al Miller on the club's Web 
site. It will be accessible to all the members for some time.  
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Should I Buy a Netbook Over a Laptop PC? 
By Mark Kyrnin,                                            About.com                                        Find the Right PC 

Question: Should I Buy a Netbook Over a Laptop PC? 

Answer: 

Netbooks are very specialized computer systems. They are designed to be compact, low cost and 
have very long running times. In order to achieve these goals, the manufacturers have to make a 
number of sacrifices. Processors must be slower and have fewer cores making them unable to run 
certain applications and slower at others. DVD drives are completely removed preventing playback 
of CDs or DVDs and making it difficult to install store bought software. They are also restricted in the 
amount of memory and storage space they can have by the Microsoft operating system licenses. 
More detail about all of this can be found in my What Are Netbooks? article. 

All of these factors make a netbook a very poor choice if it will be the sole computer in a household. 
While they are functional for basic web browsing, email and word processing, they are not very ca-
pable at any multimedia application including graphics, video and sometimes even audio. Anyone 
looking to get a low cost laptop computer would be better served by a slightly more expensive and 
less portable budget laptop PC. If price isn't an option but size is, then a more capable ultraportable 
laptop is also an option.                                                                                                                   
Now, if it is a secondary computer to supplement either a desktop computer or larger laptop com-
puter, a netbook may be a very economical option when traveling. Their small size and long battery 
life make them very good as a machine on the go to access the internet through open Wi-Fi hotspots 
from hotels, airports and coffee shops. After all, it may actually be cheaper to buy a full desktop PC 
and a netbook than a specialized high performance laptop computer. 

More PC Hardware / Reviews Q&A 

Related Resources:     What are Netbooks?Laptop PC Buyer's Guide 

Related Guide Picks:   Best NetbooksBest Budget Laptop PCsBest Ultraportable Laptops 

__  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __ 

Free program viewers still available for free can be found on Don Miller‟s Website: 

http://dmiller900.com/viewersneeded.htm 

Searching for something is also made easy here: 

http://dmiller900.com/searchers.htm 

__  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  

Quick tip: 

Make copy and paste more useful  
The clipboard is the unsung hero of Windows. It allows you to copy text from nearly anywhere. And then you 
can paste it somewhere else. This is useful for URLs, news articles, instant messaging, e-mail and more. 
But the clipboard can only hold one thing at a time. You can copy a block of text and paste it somewhere else. 
Then you have to go back for the next block. To copy and paste multiple things, you have to go back and 
forth. Ditto takes away this limitation. It allows your clipboard to hold more than one entry. So copy a URL and 
some text and a few e-mail messages. Then paste them wherever you‟d like without going back and forth. 
Your clipboard holds it all. You can copy and paste just like you‟ve always done. But when you want to acti-
vate Ditto, just press Ctrl + `. You‟ll see a list of past copies. Just click on the one you want to paste.  

Cost: Free                                                                                                                                             
Link: ditto-cp.sourceforge.net                 System: Windows XP, Vista and 7 

http://compreviews.about.com/bio/Mark-Kyrnin-8976.htm
http://www.about.com/
http://compreviews.about.com/od/buyers
http://compreviews.about.com/od/buyers/a/Netbooks.htm
http://compreviews.about.com/od/budgetnote/tp/BudgetNotebook.htm
http://compreviews.about.com/od/ultraportables/tp/Ultraportables.htm
http://compreviews.about.com/od/ultraportables/tp/Ultraportables.htm
http://compreviews.about.com/od/buyers/f/
http://compreviews.about.com/od/buyers/a/Netbooks.htm
http://compreviews.about.com/od/buyers/bb/NotebookPCs.htm
http://compreviews.about.com/od/netbooks/tp/netbooks.htm
http://compreviews.about.com/od/budgetnote/tp/BudgetNotebook.htm
http://compreviews.about.com/od/ultraportables/Ultraportable_Laptop_PCs.htm
http://dmiller900.com/viewersneeded.htm
http://dmiller900.com/searchers.htm
http://ditto-cp.sourceforge.net/
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Transfer programs to a new PC                            http://www.komando.com 

 

Q. I bought a computer running Windows Vista. I'd like to transfer over my favorite programs. There 
has to be a simple way to do this. Hopefully, you can help me. 

 

A. Getting a new computer is always exciting. But setting it up can take some work. 

Migrating your important files isn't hard. You can use a CD, DVD or an online backup service like 
Carbonite. But moving programs is harder. 

Your programs use data in many different files and folders. Most often these are stored in your Pro-
gram Files folder. Unfortunately, a program is more than the sum of its files. You can„t just copy over 
these pieces and expect it to work. 

Installing a program does more than add files to your computer. It adds essential entries to the Win-
dows Registry. It sets associations, so Windows will know how to open files. It creates Start menu 
icons and desktop shortcuts. Simply moving the program files won't do any of this. 

I'll bet your new PC is running 64-bit Vista. Most new computers are sold this way. And chances are, 
your version of XP is 32-bit. Your version of Vista can run 32-bit programs just fine. But this compli-
cates the change-over. 

The best solution is to do a fresh install on your new computer. You'll need your original installation 
discs. You can also download any programs available online. Find old favorites and new ones in my 
Download section. This will take extra time. But it's worth it. 

There are other solutions if you're willing to spend some money. You could try Laplink's PCmover 
($40). You can also try Vista's Easy Transfer feature. The simplest way to do this is with an Easy 
Transfer Cable. You can find one online for around $30. These solutions aren't perfect. They are not 
guaranteed to move every program you use. 

Carbonite can back up and transfer some programs. However, I don't recommend using it for this 
purpose. It's a great service for protecting your important data. But most programs should to be in-
stalled the old-fashioned way. 

You may have to upgrade some of your programs. This is especially true of security programs. 
Some common anti virus and firewall programs do not work with 64-bit Windows. This tip will help 
you find compatible security software. 

 

Setting up a new computer is a big project: 

Removing  bloatware from a new PC 

 

Learn how to get a new PC up and running 

 

New Mac‟s need to be secured too 

 

 

http://www.komando.com/
http://www.laplink.com/pcmover/
http://www.komando.com/tips/index.aspx?id=7014C:/Documents%20and%20Settings/USER/My%20Documents/Downloads
http://www.komando.com/tips/index.aspx?id=7091
http://www.komando.com/tips/index.aspx?id=4370
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Should you keep an XP machine?                                             http://www.komando.com 

Q. I have a laser printer, scanner and other hardware connected to an XP machine. I have all of the 

hardware shared over my network. Should I keep the XP machine? Windows 7 computers could ac-

cess the hardware via the network. I wouldn‟t need to worry about virtual XP and hardware compati-

bility. 

 

A. This question isn‟t so easily answered. And it sounds like your question is a little premature.                                                                                      

It doesn‟t sound like you‟ve checked your hardware for compatibility problems yet.   

So, before you make any decisions, download the Windows 7 Upgrade Advisor. This handy little 

program will check your machine for Windows 7 compatibility. It also checks your software and     

peripherals. You may not be planning on upgrading the XP machine to Windows 7.                      

That doesn‟t matter. The Upgrade Advisor will help you make a more informed decision about print-

ers and the like. You may find that your peripherals will run with Windows 7. In that case, you can 

get rid of the XP machine.                                                                                                                                          

It may turn out that some hardware isn‟t compatible with Windows 7. In that case, you‟ll need to do 

some thinking.                                                                                                                                 

You‟ll pay to keep the XP machine running all the time. If you just need, say, a printer, you might 

want to buy a new one. You could donate the old one to charity. With the holidays coming up, you‟ll 

find deals on hardware. Just be prepared to brave the crowds! 

Perhaps multiple gadgets are incompatible with Windows 7. In that case, it may be a good idea to 

keep the XP machine running. You could transition to Windows 7-compatible gadgets over time. 

Another solution is to use XP Mode. This creates a virtual XP machine in Windows 7. In theory, it‟s 

the perfect solution for compatibility problems. In reality though, XP Mode is not a good solution for 

most people. XP Mode has very specific requirements. And it can be difficult to tell if a machine 

meets these requirements. 

I‟ve already written about XP Mode. So, I won‟t go into it again here. If you want to learn more about 

how it works, hit my site. You‟ll also learn about the requirements. 

If you decide to get rid of any hardware, do it right. Donate it to a charity or family member.            

Or, recycle it. My column covers your options. 

In either case, wipe any hard drives. With enough determination, data can be recovered from them. 

Heidi Eraser is a great free program for wiping hard drives. You can get it on my site.                                                                                                   

Check my step-by-step instructions for using it. Otherwise, your data could still be exposed.                 

_  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __  __ 

Quick tip: 

Closing open Windows faster                                                                                                    

Pressing the Alt+F4 keys is a fast way to close any foreground window in all current versions of Win-

dows. Or, right-click on the taskbar button for any open window, and select Close window from the 

context menu. 

http://www.komando.com/
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Open links in Firefox                                               http://www.komando.com 
 

Q: Why do your newsletter links open in Internet Explorer when you seem to be such a supporter of 
Firefox? I, too, use Firefox and would like to open your links in it. 

 

A: Some questions are one-shot deals, never to be heard from again. Others never go away. 

This is one of the latter. I‟m sure I addressed it first when Netscape was the big browser.            
Nonetheless, it continues to bedevil people. The problem probably is on your end. Firefox has to be 
your   default browser. Those settings tell Windows which browser to associate with links. 

That is easily set in Firefox. Click Tools > Options. Select the Advanced tab. Click Check Now.     
Set the default and click OK. 

You can make doubly sure that everything is set up. In Windows 7 and Vista, click Start > Control 
Panel. Double-click Default Programs. Click “Set your default programs.” Click Firefox, Click 
“Choose defaults for this program.” Assuming you want to use Firefox for everything, click Select All. 
Click Save > OK. Close the windows. 

Things are different in Windows XP.  Click Start > Control Panel. Double-click Folder Options.      
Select the File Types tab.                                                                                                                                        
Scroll down to HTM. If it says Firefox Document, you‟re all set. If not, look below, under “Details for 
HTM extension” Click Change. 

Hopefully, Firefox will be listed under Recommended Programs. If so, click it. Select “Always use the 
selected program to open this kind of file.” Click OK. If Firefox is not on the list, click Browse. Go to 
the Firefox folder. On my computer that is C:\Program Files\Mozilla Firefox. 

Double-click the Mozilla Firefox folder. Click firefox.exe and click Open. Again, select “Always use 
the selected program to open this kind of file.” Click OK. 

Do the same with the HTML extension, below HTM. Then scroll down to the XHT and XHTML exten-
sions. Those also should be set for Firefox.   

It‟s possible that you‟ll want to return to Internet Explorer someday. You can do that directly in IE. 
Click Tools > Internet Options. Select the Programs tab. Click Make Default > OK.   

That should take care of everything. You can double-check by following the previous procedures for 
Firefox.                                                                                                                                                   
If you need to browse for IE in Windows XP, it‟s at C:\Program Files\Internet Explorer.                   
Select iexplore.exe. 

Everyone should give Firefox a try. Many computer threats try to exploit browser flaws.                  
Because Internet Explorer is part of Windows, I consider it less safe. Firefox does not have that 
problem. You can download Firefox through my site. 

There are other good browsers available. You can get them through my site, too. 

 

Apple Safari 

 

Goggle Chrome 

 

Opera  

http://komando.com/
http://komando.com/
http://komando.com/
http://www.apple.com/safari/
http://www.google.com/chrome/index.html?hl=en&brand=CHME&utm_source=en-us-hpp&utm_medium=hpp&utm_campaign=en
http://www.opera.com/
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Your identity was stolen. Now what?                         http://www.komando.com 

Q. I learned today that someone opened a phone contract in my name. I've never been a crime victim, and 

I'm frightened. My sister said the police wouldn't do anything. Will your identity theft service help me? 

A. Identity theft is one of the most common crimes today. I‟m sorry you‟ve been victimized. Cleaning up after 

identity theft takes a lot of time and work. 

I have spoken to a lot of people who had their identities stolen. All had one thing in common. They never 

thought it would happen to them. 

There‟s so much information about us floating around online. We use our credit cards all over. It‟s not hard for 

someone to get the information they need to steal our identities. 

The service you mentioned is ProtectMyID  (a sponsor on my radio show). And yes, it can help you.         

There are things you need to do now. It‟s important to act quickly. Having a phone contract opened in your 

name is scary. But the thieves haven‟t really dinged your credit yet. Acting now will minimize further damage. 

I don‟t agree with your sister. You absolutely need to report this to the police. Filing a report is an important 

first step in setting things right. You‟ll get a copy of the report. It can help remove fraudulent purchases from 

your credit history. If any luck, the police will catch the criminals. 

Next, contact the FTC (Federal Trade Commission). Visit this Web site, and follow the instructions for filing a 

complaint. You‟ll get a copy of your report as well. Add this to your police report. Together they make up a 

comprehensive identity theft report. Again, this will help you dispute fraudulent charges that may start appear-

ing. 

Next, call the three credit-reporting agencies. Place a fraud alert on your credit report. This is really easy. 

Each agency has a toll-free number. 

Trans Union - 1-800-680-7289 

Equifax - 1-888-766-0008 

Experian - 1-888-397-3742 

You should only have to call one of them. They are required to pass fraud alerts on to the others. Each should 

send you a confirmation in the mail. If you don‟t get confirmation from all of them, call each individually. 

Finally, you need to sign up for ProtectMyID. If you had signed up before now, this wouldn‟t have happened to 

you. ProtectMyID would have stopped it. You would have received an e-mail or text alert when someone tried 

to open the phone account in your name.                                                                                                       

ProtectMyID will help stop the criminals from doing any more damage. They apparently have the information 

they need. It would be easy for the thieves to strike again. And your information is probably being sold online 

by this point, too. 

Click here to get protected now with ProtectMyID.com. There‟s a 14-day money back guarantee. If you don‟t 

like it, you get your money back. It‟s less than $10 a month. Now, that‟s affordable protection. 

After you sign up, call 1-877-308-6943 and explain what happened to you. You will be assigned a dedicated 

Fraud Resolution Agent who will work on your situation. This is another thing I like about ProtectMyID. You 

have one person assigned to your problem. You‟ll need this additional assistance and appreciate one individ-

ual who knows your case. 

I use ProtectMyID and that‟s why I recommend it to you. Click here to learn more. 

 

http://www.protectmyid.com/default.aspx?PageTypeID=HomePage42&SiteVersionID=868&SiteID=100302&sc=670183&bcd=9964791164620
https://www.ftccomplaintassistant.gov/
http://www.protectmyid.com/default.aspx?PageTypeID=HomePage42&SiteVersionID=868&SiteID=100302&sc=670183&bcd=9964791164620
http://www.protectmyid.com/default.aspx?PageTypeID=HomePage42&SiteVersionID=868&SiteID=100302&sc=670183&bcd=9964791164620
http://www.protectmyid.com/default.aspx?PageTypeID=HomePage42&SiteVersionID=868&SiteID=100302&sc=670183&bcd=9964791164620
http://www.protectmyid.com/default.aspx?PageTypeID=HomePage47&SiteVersionID=868&SiteID=100302&sc=670070&bcd=landingpage&areaid=22&pkgid=X3THZ
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       Antivirus up to date? 

      Firewall? 

      Windows up to date? 

      Spy Ware? 

      See how to protect your computer at: 

               http://www.gtbpcug.org/protect/ 

 

                                                                 More about Internet Threats 

Create a disposable e-mail address                                       http://www.komando.com 

 

Spam is a big problem for e-mail users. For many users, spam accounts for the majority of mes-
sages received. 

A good spam filter will help you reduce spam. I recommend that everyone use one. But you can do 
more. 

Download the Show! In fact, your best bet is to share your e-mail address judiciously. If you're not 
sure how a site will use your address, don't disclose it. 

Of course, that's easier said than done. You may need to provide an e-mail address for an offer or 
an online order. 

In that case, try Jetable. The readers who speak French will realize that this means "disposable." 

As the name implies, Jetable will help you create a disposable e-mail address. Start by disclosing 
your real e-mail address. Then specify a lifespan for your disposable address. (Up to one month) 

Messages sent to your disposable address will be forwarded to your real one. After your Jetable   
address expires, you will no longer receive messages sent to it. 

Now, there are a couple downsides to Jetable. If you respond to a message, you will reveal your true 
e-mail address. Also, it is not anonymous. 

 

 

—  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —  —   

Quick tip:    

Speed-up IE8: 

This simple procedure might be worth a try to speed-up IE 8. 

Go to Start >Run >type in: CMD > and at the curser type in: regsvr32 actxprxy.dll > Hit Enter. 

(Notice the space between: 2 and a) 

After you see: "DllRegisterServer in actxprxy.dll succeeded" >click OK and restart the PC. 

 

 

            Is Your Internet Security up to Date? 

http://gtbpcug.org.protect
http://www.jetable.org/en/index
http://www.jetable.org/en/index
http://www.jetable.org/en/index
http://www.jetable.org/en/index
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One thing is even worse than online pornography 

when it comes to your PC's safety and security: 

Digital music                                                  www.daol.aol.com 

 

Surprised? Searching for digital music is twice as risky to your computer's safety and security as 

viewing online pornography, according to McAfee Inc., a Santa Clara, California-based company 

that makes computer-security software. Specifically, just 9 percent of adult sites are associated with 

PC-damaging problems such as spyware, adware and spam, while fully 19 percent of digital music 

sites will infect your computer.  

Why isn't pornography a greater threat to your PC? The business side of that industry works without 

extra hustling, reports The Los Angeles Times. It's much harder to make a buck selling digital music, 

so it's more likely there will be unwanted ads -- or worse -- attached to those programs. "The tier-one 

adult sites are doing phenomenally well as businesses, and because of that they very much have 

their house in order," McAfee senior product manager Mark Maxwell told the Times.  

The single riskiest search term is for the peer-to-peer music and video file sharing application 

"BearShare," since search results so often include intrusive advertising. Type in "BearShare" into 

any search engine, and fully 46 percent of the resulting sites are unsafe, according to McAfee's test. 

Searching for celebrities can be dangerous too. But some celebs are worse than others. McAfee 

found that doing a search for Britney Spears generated more dangerous sites than doing a search 

for Lindsay Lohan. And, it's unclear why but searching for Brad Pitt and Jennifer Aniston is 36 per-

cent more likely to bring up hazardous results than searching for Brad Pitt and Angelina Jolie.  

Four percent of all search results link to risky Web sites. Other risky sites include screen savers and 

background wallpaper for your computer monitor. Fully 42 percent of the hits for a search using the 

word "screensavers" result in questionable sites, according to McAfee's study. 

There is good news: The very worst sites -- which automatically install keystroke loggers and other 

malicious programs -- remain small, with less than 1 in 1,000 hitting the top search-engine results in 

McAfee's test. 

What is the safest search engine? That would be AOL Search. McAfee found that just 2.9 percent of 

AOL search results resulted in risky sites, compared with Yahoo!, which had the most at 5.4 percent.  

http://daol.aol.com/articles/whats-riskier-than-porn?icid=main|main|dl5|link3|http%3A%2F%2Fdaol.aol.com%2Farticles%2Fwhats-riskier-than-porn
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LOST. IMPORTANT WORD FILE. LAST SEEN ON MY         

COMPUTER. REWARD AVAILABLE.                          AOLDiscover.com 

 

We‟ve all had that moment. That gut-wrenching, sinking feeling of dread, often verbalized by an em-

phatic “Oh [insert word of choice]!” Your file, the one you were working on for the last few hours, 

days, even weeks -- is gone. Whether it‟s due to a user error or a computer malfunction, it‟s painful 

to lose it. 

The computer whizzes tell you over and over to save your document every few minutes. But let‟s be 

real: once you‟re in the thick of it, it‟s annoying to  

 

Stop.  

Save.  

And start again.  

 

Some programs now come with a handy function that automatically saves your documents in a tem-

porary folder. However, it‟s not always easy to find those files.  

One quick recommendation from a non-computer whiz: as soon as you open a new document or file, 

save it with whatever name you want to call it (even if the document is still blank). That way, if you 

get interrupted and lose the file, it‟s a lot easier to recover.  

 

Deleted Files 

The good news: if you accidentally (or purposefully) delete a file, chances are it‟s not actually gone. 

Windows often keeps deleted files in the Trash or Recycle Bin. Double-click the Recycle Bin icon on 

your desktop to see what's inside. You can drag and drop the file to the location you want, or right-

click on the file and select Restore, which will automatically return it to the location from which it was 

deleted.  

Lost Files 

If you‟re in the middle of working on a document and your program freezes, crashes or is forced to 

close before you can save, all may not be lost. Many documents can be partially if not fully recov-

ered.  

The first step is to search for the original document. Make sure you can view hidden files so you get 

a full result list. To enable this view, in Windows Explorer click on Tools and then Folder Options. 

Click on the View tab and make sure the “Show Hidden Files and Folders” option is marked.  

Next, click the Start button and select Search (there‟s usually a magnifying glass next to it). Click on 

“All Files and Folders.” This is where it comes in handy to name and save a file as soon as you open 

it. Many programs, including Microsoft Office (Word, Excel, PowerPoint), will auto-save what you're 

working on every few minutes. So, even if you haven‟t saved in a while, you might be able to find a 

more complete version that was auto-saved before the crash. In the box under “All or Part of the File 

Name,” type the name of the document you want to find. In the “Look In” drop-down box, click on My 

Computer and/or your lettered drives if you have a networked machine. Then click Search.  

If you don‟t remember the file name or didn‟t name your file, try typing a * and then the extension 

(the three-letter acronym for the type of file). For example if you are searching for a Word document, 

type *.DOC in the “All or Part of the File Name” box.                                                                                                          

                                                                                                                                                                        Continued on the next page                                                                                                        
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Automatic Backup Tools  

If you were working in Microsoft Word and were savvy enough to plan for these sorts of disasters by 

proactively enabling the Always Create a Backup Copy tool before the crash, you can take the 

above steps but in the “All or Part of the File Name” box, type *.WBK and click Search. 

What‟s the Always Create a Backup Copy tool, you ask? In Word, click on Tools and then Options. 

Click on the Save tab, you‟ll find a check box called Always Create a Backup Copy.  

 

AutoRecover 

In this same Tools/Options dialogue box, you also have the option to change how frequently Word 

auto-saves your files with the AutoRecover option. If you‟re like most and don‟t save at regular in-

tervals, you might consider setting it to auto-save frequently.  

 

The Autorecover feature is available on most Microsoft Office programs, and provides an emergency 

backup for open documents if an error occurs. Keep in mind: this is not a substitute for saving, as 

these files are not stored indefinitely. A temporary file can include all changes that were made prior 

to the last auto-save. So, if you are auto-saving every two or three minutes, you should be able to 

get most of the document back. If you have a crash and this feature is enabled, try re-opening the 

program (Word, Excel, PowerPoint) you were using. The program should open with an AutoRecover 

pane that displays the most recently auto-saved files. If the file does not appear, you can manually 

search for AutoRecovered files by following the steps above to search for a file. In the “All or Part of 

the File Name” box, type: *.ASD and search in My Computer.  

 

Temporary Files 

Another option is to recover the document from your temporary files. Follow the steps above to 

search for a file. In the “All or Part of the File Name” box, type: *.TMP. This will bring up a lot of files, 

so you can narrow your search by clicking “Specify Dates” and do a search limited to the time period 

that you last worked on the file.  

 

Sometimes temporary files are stored with a tilde symbol (~) and might not appear in a *.TMP 

search. If you didn‟t find what you were looking for, repeat the search above but in the “All or Part of 

the File Name” box, type: ~*.* and modify your dates.  

 

One Last Thing 

If your file is still lost, or if you don‟t want to go through all these steps, there is software available 

like Search & Recover -- which scours your hard drive to find deleted and lost data. Programs like 

Search & Recover are especially handy if the file was lost long ago, as the temp and Autorecover 

saves only hold onto data for a short period of time.  

 

When all else fails, it may be time to talk to a techie for a forensic review. Which can get to be pricey. 

Which serves as a reminder…  

 

Stop.  

Save.  

Start again.  

http://aolproductcentral.aol.com/ClickBroker?campaign=6a63f43c-cbc9-4071-90ac-565f2e51f309
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Something to look into…                                            Collected by the editor and other members 

http://lab.andre-michelle.com/tonematrix  

You will not become another George Gershwin in an instant, but if you like music and have an ear 

for it this site could be a lot of fun to find out how much of a composer you are. Don‟t forget, the only 

way to get to Carnegie Hall is: practice, practice, practice! 

http://walletgarden.com/ 

You open a free account by giving a current e-mail address, choose a password and you are ready 

to create a card with all the important telephone numbers to call in case you loose your wallet or 

have it stolen. The notes you made that contain all those numbers are at home and you are on     

vacation. All you have to remember is http://walletgarden.com/ and from any Computer you can re-

trieve your stored information. Sometimes minutes are of the essence in case of a stolen credit card. 

http://www.spywarewarrior.com/rogue_anti-spyware.htm#sites                     Submitted by Charles Kelly 

Those who have followed the development of this page since 2004 will have noted that the list of 

"rogue/suspect" anti-spyware products has not been updated since May 2007. Unfortunately, other 

time commitments have precluded our efforts to keep that list up to date. Since the last update doz-

ens of "new" rogue anti-spyware programs have hit the 'Net. The vast majority of them however, are 

not really new, but are simply re-branded clones and knockoffs of the same rogue applications that 

have been around from years. In most cases, they are being pushed through the same deceptive 

practices by the same parties responsible for earlier versions.  

http://www.komando.com/downloads/category.aspx?id=8442 

Even in the fast-paced world of digital entertainment, people still like books. There is something re-

freshing about exercising your imagination, for a change. Hopefully that won't be lost as books 

gradually change format. Digital books are in the news quite a bit lately. However, audio books aren't 

mentioned much. In fact, audio books have always stayed under the radar. Of course, reading a 

book yourself is better, when you have the opportunity. The problem sometimes is finding them, and 

at a decent price.  

http://www.google.com/chrome/intl/en/privacy.html                          Submitted by member Frank Weitzman 

This site is for information on the privacy implications of Chrome features.  The only machine-

specific information Chrome sends to Google is randomly-generated installation ID that's unique to 

your install the first time it checks for updates. After that initial check you've been counted and it de-

letes the installation ID. The privacy implications were a little bit different before Chrome 4.1:      

http://blog.chromium.org/2008/10/google-chrome-chromium-and-google.html                                                                                                                        

The main differences is that the ID wasn't deleted prior to 4.1. I don't immediately see any official in-

formation from Google about what information from the update requests was logged and for how 

long it was retained prior to 4.1, but trying to track a person down on an unusual network by their 

Chrome ID would be no different in principle than trying to track them down by their Windows Up-

date requests or through a website they may have logged into while on that network or used without 

clearing their cookies. Also note that you can turn off any Chrome features that may have privacy 

implications except for automatic updates.                                                                                                                          

                                                                                                                                

http://lab.andre-michelle.com/tonematrix
http://walletgarden.com/
http://walletgarden.com/
http://www.spywarewarrior.com/rogue_anti-spyware.htm#sites
http://www.komando.com/downloads/category.aspx?id=8442
http://www.google.com/chrome/intl/en/privacy.html
http://blog.chromium.org/2008/10/google-chrome-chromium-and-google.html
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Congratulations!                                

Pat LaTerza 

I took this picture of the     

Korean War Memorial this 

month,                                                                                                                                                

April 2010 in Washington 

DC. 

Camera Kodak Z712  7.1mp 

and 12 optical zoom. 

Manual setting, no flash. 

Zoomed in Photoshop                 

Elements5 to 33 % and             

resized to 800 x 555 with  

Microsoft Power Toys.  

The April contest winners were Dick Evans and Pat LaTerza 

Dick Evans 

Taken at Anna Maria Island,  

September 2008  

Fujifilm S5100 camera, 

"automatic" settings. 

 

 

 

Note:                                                                                                                                                                            

The $20.00 give-away contest is continuing during the rest of the year, and not just a one-time affair. We still are 

hoping for more participation.  There will be two winners from now on with $10.00 to each winner!                                                                                          

Editor 
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